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For network professionals and system administrators, the following skills are assumed:

Proficiency with Windows-based applications

General knowledge about mobile networks and expert knowledge about high-frequency components
such as cable attenuators

System administrators are also expected to be familiar with the network test processes and
standards of the test labs in which AIS will be used.

Prerequisite skills
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1 Introduction to AIS

1.1 About AIS

The Qosmotec Air Interface Simulator (AIS) is a tool, which simulates essential effects of
signal propagation through open space, such as the free space path loss, slow or fast
fading, on a mobile radio link between mobile terminals and the network infrastructure. As
the name suggests, the tool shall be used in a laboratory environment to simulate aspects of
the air interface that do not occur in cabled configurations, but which are of utmost
importance for network or terminal validation. It is thus aimed at infrastructure or mobile
equipment manufacturers or network operators that are performing end-to-end tests in a
controlled laboratory environment. It can be applied to tests of network as well as terminal
equipment.

To simulate the air interface, the AIS hardware uses signal attenuators that are regulated by
computer to control the individual radio paths between base stations/sectors and mobile
phones. AIS can provide up to 32full bandwidth GSM/GRPS or UMTS radio paths in one 19
inch metal enclosure.

A graphical user interface (GUI) enables testers to create configurations of base
stations/sectors mobile phones, and other elements of a natural environment such as hills,
tunnels, and buildings. In these configurations, the movement of mobile phones is tracked
and the signal strength between mobile phones and base stations/sectors is adjusted
accordingly. As a result, AIS can create realistic simulations of handover and fast fading
situations. Because these configurations are computer-controlled they can be saved and
reused and run automatically with minimal support from testers.

Note:
AIS creates the environmental conditions for handovers but it does not enforce handovers.
That is the task of the mobile network.

AIS does not perform the test calls during which handovers are expected to occur. Testers
perform handover tests either by controlling the mobile keypad manually, or by using an
automatic callgenerator.

1.2 The AIS system components

The AIS system consist of the following hardware and software components:

The subrack

The attenuator modules

The AIS server

The AIS resource manager

The AIS switch matrix

AIS client
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1.2.1 The Subrack

The Qosmotec Air Interface Simulator consists of both hardware and software components.
The hardware resides in a 19" metal case, termed Subrack fitting up to two drawers with
connectors for four base stations and four mobile station antennae each. On the backside of
the subrack, data network (fast Ethernet) connection and power supply (220 volts) are
provided. Each mobile connector is internally linked to each base station connector via a
separate semiconductor attenuator, which can be addressed and controlled individually. The
network connection allows connecting remote terminals to the attenuator hardware and
controlling the hardware via GUI clients

Air Interface Simulator Subrack

The AIS is equipped with an internal CPU. The CPU is a standard industrial PC-compatible
microcontroller board with connectors for external data networks and a bus for internal
access of the attenuator modules. The CPU runs the software that drives the attenuators
and the server process, which provides a set of functions to operate the attenuators from
remote clients.

1.2.2 The attenuator modules

The AIS hardware furthermore encloses a number of so called 2x2 Attenuator Modules that
each contain 4 semiconductor attenuators with a response time of 8 µs.
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Each attenuator module links 2 base stations with 2 mobiles, so that each mobile is
connected via an individually controllable link to each base station. Four attenuator modules
are cascaded into a basic 4x4 configuration, interconnecting 4 mobiles with 4 base stations.

Internal Architecture of the AIS Hardware

Each attenuator assembly contains either 16 GSM/GRPS attenuators or 16 UMTS
attenuators. These 16 attenuators support 16 individually modulated radio paths.

For GSM/GRPS attenuators, the range of attenuation is 0 to 63 dB within a frequency range
of 800-2000 MHz.

For UMTS attenuators, the range of attenuation is 0 to 95 dB within a frequency range of
1600-2500 MHz.
The attenuator modules are adjustable by software control in 1 dB steps. The response time
of an attenuator is 8 micro-seconds.

The base configuration is 4x4 (4 mobiles and 4 base stations/sectors.). This is realized with
one drawer put into a subrack.

Two 4x4 configurations can be externally connected by using cables to form a single 8x4
configuration (8 mobiles x 4 base stations/sectors or 4 mobiles x 8 base stations/sectors).

To create larger configurations of mobiles and base stations/sectors, the signal needs to be
split. Splitter-combiner panels can be provided for this purpose.
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There is an additional attenuation of the signal of 4 dB when a splittercombiner panel is
used. For this reason, the largest configuration possible is 8x8. An 8x8 configuration for
UMTS is shown in the following figure.

An 8x8 configuration

When two subracks are used, the server in one subrack acts as the master and the other
server acts as the slave so that users of the AIS GUI see one system rather than two.

1.2.3 The AIS server

The AIS server is a software program that runs on the micro-controller inside the AIS
subrack (see chapter "The Subrack")and calculates and controls the signal strength of the
attenuators in a subrack. These calculations take into account the position of mobiles and
base stations/sectors in the virtual landscapes created on the AIS clients.

1.2.4 The AIS resource manager

The AIS software provides a simple resource manager for multi-user access. The resource
manager handles requests for mobile groups from users and it ensures that allocated mobile
groups cannot be accessed or monitored by other users.

1.2.5 The AIS switch matrix

The AIS switch matrix is an optional component, that allows to connect more base stations to an AIS
than actually usable due to the number of attenuators. With an m x n switch matrix, a subset of all m
connected base stations is mapped to the n BTS input ports of the AIS subrack, that can be served by
an AIS server.

The handling of the AIS switch matrix is done implicitly by the AIS server. The user clients will always
be updated with the current information of the used subset of base stations that are made usable
through the switch matrix.
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1.2.6 AIS client

The AIS GUI is installed on a client which is linked to the AIS hardware using the fast
Ethernet network in the test lab. A client is a standard PC running Windows 2000 or XP.

From the GUI, you can do the following:

Create virtual landscapes called sceneries populated with the base stations/sectors and
mobiles connected to the AIS hardware.

Move the mobiles across a scenery and monitor the changes in attenuation between the
mobiles and the base stations/sectors.

Display attenuation graphs from dial settings stored in a comma separated file.

More detailed information on these tasks is provided in the chapters Getting started,
Objects, Running Sceneries and Table file view.

1.2.7 Data Storage

The sceneries and table files, that are executed with AIS, can be either stored in a local Access
database file or in a central Oracle Database.

In case of a local data storage, the saved sceneries and table files cannot be shared among users
working on different client PCs.

To save the data in a central database, that has to be delivered and installed separately by Qosmotec,
the Oracle 9i Database Release 2 (9.2.0.1) Client for Windows 98/NT/2000/XP has to be installed on
each client PC using AIS. For installation details refer to the readme file that is delivered with the
installation version. The installation of the runtime version is sufficient to run AIS. If the Oracle Client
CD that is delivered by Qosmotec is used for the installation, no configuration needs to be done after
installation. Otherwise refer to Qosmotec support for configuration details.

To ensure stability of the Oracle client, it is recommended to install also the Oracle 9.2.0.6 Client Patch
for Windows 98/NT/2000/XP after successful client installation. For installation details refer to the
readme file, that is delivered with this patch.

2 Getting started

This chapter gives an overview how to start AIS and how to create and run sceneries.

It will be explained how to:

Install AIS

Open AIS

Log on to AIS

Work with frame windows

create and run sceneries
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2.1 Install AIS

The AIS server software and firmware is delivered by Qosmotec on a Compact Flash Card,
that is ready to run when inserted into the AIS subrack. For this make sure, that the AIS
subrack is switched off and insert the Compact Flash into the slot in the back of the subrack.

For installing the AIS Client Software, double click the setup.exe and follow the steps in the
Install Shield Wizzard. If there is already an older version of AIS installed, it shall be
removed before installing a newer version. For this, select Remove in the Program
Maintenance Window and continue.

Removing AIS

Note: Removing AIS may delete all your sceneries, if you save them in the local database
on your computer as well as all preconfigured access data to the AIS server. To prevent this,
make a copy of your database file AIS.mdb and of the configuration files ais.ini and
aisadmin.ini, that is located in your local installation directory, before removing the software.

After removing AIS from your client computer you have to start setup.exe again and follow
the steps in the Install Shield Wizzard. Select Complete in the Setup Type window for a full
installation.
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Installing AIS

By default, AIS is installed with an empty local database and empty configuration files ais.ini
and aisadmin.ini. If you use the database locally installed on your computer, you may
replace the empty AIS.mdb file in the AIS installation directory with a copy of a database file
containing entries from former AIS versions and the ais.ini and aisadmin.ini files with the
backup copy containing your access configuration data.

2.2 Open AIS

To start the AIS Client on a Windows PC select

Start -> Program Files -> Qosmotec -> AIS -> Air Interface Simulator

2.3 Logging on to AIS

Before working with AIS the user must check the server connection settings and log on to
AIS.

2.3.1 Server connection settings

Fill in the IP-Address of the AIS-Server in the IP-Address input box in the server connection
settings field of the Connection settings - Login dialog.

Fill in the port number of the AIS-Server in the Port input box in the server connection
settings field of the Connection settings - Login dialog.
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Fill in your user name in the User name input box in the login field of the Connection
settings - Login dialog.

Fill in your password in the Password input box in the login field of the Connection settings
- Login dialog.
Click "OK".

The settings can be saved under a name in the Name input box, that can be reused for later
login. For that, select the name from the Name input box selection list.

The "Connection settings - Login" dialog.

If you do not know the IP-address or the port number contact your local system
administrator.

2.3.2 Disconnecting and Reconnecting

While running an AIS client, it is possible to disconnect and to reconnect to the AIS server by

pressing the Server Connection button.  or by selecting Edit -> Disconnect from
Server ... or Edit -> Connect to Server from the menu respectively.

It is advisable to disconnect from the server before disconnecting from the local area
network, e.g. when running the AIS Client on a laptop, in order to free the license
immediately.

Before reconnecting to an AIS Server, it is possible to modify the server connection settings
and the login credentials by selecting Edit -> Server setup ... from the menu.
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2.4 Frame windows

Once the user is logged on to AIS the following frame windows appear cascaded by default:

Scenery-Map view: The scenery-map view window displays the map and the BTS/Sector
pane, the mobile group pane and the configuration pane

    
    The scenery-map view window
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Attenuation-Matrix view : The Attenuation-Matrix view window shows the current attenuation
of a mobile group to each of the BTS/Sectors in the scenery.

  
  The Attenuation-Matrix view window

If the server calibration feature is activated and the server is correctly calibrated, the user
can switch between showing attenuations or Rx-Levels. When switched to Rx Levels, the
Attenuation-Matrix view is replaced by a Rx Level Matrix view.
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Scenery-Logging view: This window shows changes and updates to the scenery, listed
according to the time when they were put into effect.

The Scenery-Logging view window

Table file view: The table file view is an application of it's own within the AIS. It is used to set
a user specified attenuation pattern of a mobile group to each of the BTS/Sectors in the
table file at a user specified time.

The table file view window

The "Scenery-Map view" window is activated by default. The user may arrange the windows
in any other mode.
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2.4.1 Arrange windows

Before the user starts working with sceneries he is advised to arrange the windows of the
AIS GUI.

The user may now arrange the windows of the AIS GUI in one of the following ways:

Cascade: Select from the menu bar Window à Cascade. In the cascade mode the
windows appear one behind each other.

Windows arranged in the cascade mode

Tile: Select from the menu bar Window à Tile. In the tile mode the windows are arranged
quarterly. If the windows are arranged in the tile mode, the table file view window is visible.

Windows arranged in the tile mode
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Auto arrange Windows (map left): Select from the menu bar Windowà Auto arrange

windows (map left) or click on the arrange frame windows (map left) button  in the
tool bar

Windows auto arranged map left

Auto arrange Windows (map top): Select from the menu bar Window à Auto arrange

Windows (map top) or click on the arrange frame windows (map top)  button in the
tool bar.

Windows auto arranged map top

To bring a frame window to front and activate it select from the menu bar Window and the
window you want to activate, e.g. WindowàScenery-Map view.
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2.5 Sceneries

2.5.1 Create a new scenery

If a scenery is already opened in the AIS GUI and the user wants to create a new scenery
Select from the menu bar FileàNew Scenery (AIS instance) or press Ctrl+N.

If no scenery is opened, the user may start to create a new secenery by placing objects on
the map.

See also section "Example: Run AIS"

2.5.2 Open existing scenery

To open an existing scenery from the menu bar FileàOpen Scenery or press Ctrl+O.

The open scenery dialog appears.

The Open scenery dialog

Select a scenery from database or type name of the scenery you want to open in the name
field and click open.

If a scenery has been running for a while and the number of log entries exceeds 10.000, the
user will be given the opportunity to load only the last 10.000 log entries to avoid long
loading times. A pop up window prompts the user to decide whether to load only the last
10.000 log entries or not, before the user is able to work with the scenery.

The load log entries dialog

Note:
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When a scenery is already open and you try to open another scenery, AIS will try to start
another instance of AIS. You can only open as many sceneries as you own licenses.

2.5.3 Save scenery

To save a scenery select from the menu bar FileàSave Scenery or press Ctrl+S.

If the scenery has been saved before, the current scenery will be overwritten.

If the scenery has not been saved yet, the Save scenery window appears.  Fill in a name in
the name input box and click Save. The user may also write a short comment about the
scenery in the comment input box of the Save scenery window before saving.

All sceneries are saved in the database.

If a scenery shall be saved under a new name, select from the menu bar FileàSave
Scenery As…. The Save scenery window appears. Fill in a name in the name input box and
click Save.

The save scenery dialog

2.5.4 Close scenery

To close a scenery select from the menu bar FileàClose Scenery. The user is prompted to
save the scenery before the scenery is closed, if any changes have not been saved yet.

2.5.5 Delete Scenery

There are the following possibilities to delete a scenery:

To delete an already open scenery, select File à Delete current scenery from database
from the menu bar.
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It is also possible to delete a scenery from database via the Open scenery or the Save
scenery dialog. Select a scenery from the database or type the name of the scenery you
want to delete in the name field and click on the Delete button.

Database with stored AIS files

2.6 Example: Run AIS

It is a assumed that the user is logged on to AIS, the windows are already arranged and no
scenery is running.

Activate the Scenery-Map view window.

Select a BTS/Sector from the BTS/Sector pane and place the BTS/Sector on the map either
by drag and drop or select from the menu bar: Objects à Base station/Sector à Add to
map.

Scenery map with BTS/Sector
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Select a mobile group (MG) from the mobile group pane and place the mobile group on the
map by drag and drop.

Scenery with BTS/Sector and mobile group
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Add a new trail to map.
Either by selecting from the menu bar Objectsà Trail àAdd to map or click on the add

new trail button  in the tool bar.
Click with left mouse button at the position on the map, where you want the new trail to start.
Click with left mouse button at the position on the map where you want the trail to end. To
finish the trail, click right mouse button.

Scenery map with BTS/Sector, mobile group and Trail

Instead of a trail the user may also place a random walk area on the map.
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Connect the mobile group to trail
To connect a MG to a trail click on the MG with right mouse button and select Connect to
Trail/Random area from the MG menu. A small square now appears on the peak of the
cursor.

Mobile group menu

Move the cursor to the trail's reference point  to which the selected MG shall be connected.
When the reference point of the trail turns red, realease the left mouse button to connect MG
to trail.

To run the scenario allocate the mobile group on server by selecting a MG and select
allocate on server from the MG menu or select from the menu bar Objects à

Mobilegroup à Allocate on server and click on the start the session button  in tool
bar.

3 Objects

3.1 Objects in general

The AIS software application offers several objects with which the user may work. These
objects are the following:

BTS/Sector 

Mobile groups
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Trails

Random walk areas

Shaded areas

Fast fading areas

All of these objects feature different attributes and functions which are explained in the
chapters relating to the specific objects. The general handling that applies to all objects and
is explained once in general for all objects.

Reference Points
Each object has a reference point (RP). The RP is shown as a small square within the
object, e.g. in the middle of a BTS/Sector or at the beginning of a trail.

Reference point of a BTS/Sector

The user may decide whether the RPs of the objects in the scenery shall be shown or
hidden. To show or hide the RPs in a scenery click on the show/hide reference points

button  in the tool bar or select from the menu bar ViewàShow/Hide reference points.

The object menu is accesable by clicking with the right mouse button on the object's RP.

Selection
There are the following possibilities to select an object:

Click on the RP of an object with the mouse.

BTS/Sectors and mobile groups may also be selected by clicking on them in either the
BTS/Sector or mobile group pane .

If an object is selected, the configuration pane for the selected object appears below the
mobile group pane.

Configuration
When the user changes the configuration of an object the changes are enabled by pressing
"enter" or clicking anywhere on the map.

3.2 BTS/Sectors

A Base Transceiver Station (BTS/Sector) transmits radio signals to the mobile groups
connected with the AIS hardware. The default radio propagation model set for a BTS/Sector
channel is the free space path loss model, but it is possible to set user defined radio
propagation models for a BTS/Sector. The frequency dependent signal loss according to this
model in dB is indicated by contour lines around the BTS symbol.
A BTS/Sector can consist of several channels, that are individually connected to different
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ports of the AIS Hardware. The channels of a BTS simulate different antennas of a Base
Station transmitting radio signals to the mobile groups connected with the AIS hardware in
the same way like a BTS/Sector with only a single channel.

In this section it is explained how to:

Add BTS/Sector to map

Reserve a BTS/Sector for exclusive usage

Configure BTS/Sector

Delete BTS/Sector

3.2.1 Add BTS/Sector to map

Select a BTS/Sector from the BTS/Sector pane.

The BTS/Sector pane

Place the BTS/Sector on the map either via drag and drop or select from the menu bar:
ObjectsàBase station/SectoràAdd to map.

All BTS/Sectors, that are added to your current scenery view are bold printed the BTS/Sector
pane.

If the selected base station is not in use by any other user, the output radiation power of the
BTS can be configured in the Radiation dialog, that pops up, when adding the base station
to the map. The default value that is shown is read from the configuration, that is set in the
AIS Administration GUI
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The Radiation Power dialog

The number of base stations, that are served by one server depends on the number of
Switch Matrix Ports n, that are served by the AIS Server. If the number of base stations, that
is added to the Scenery-Map View by all the users that are logged in to the AIS Server
reaches the number of Switch Matrix ports, all other base stations become unavailable and
will be greyed out in the BTS/Sector pane.

The names of all users, who have added a base station to the Scenery Map View are listed
in the used by column of the BTS/Sector pane. By default, it shows the first user of the base
station. All current users can be retrieved as a tooltip.



Objects 27

© <2005> Qosmotec Software Solutions GmbH

BTS in scenery map

To change the position of a BTS/Sector on the Map, either drag BTS/Sector to a new
position or fill in new coordinates in the input boxes of the Position field of the configuration
pane.

3.2.2 Exclusive BTS/Sector reservation

A user can reserve a BTS/Sector, that is not in use by any other tester, exclusively by
selecting Exclusive Reservation from the BTS/Sector menu or selecting Objects à Base
station/Sector à Exclusive Reservation.
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Exclusive Reservation from the BTS/Sector menu

Base stations, that are reserved exclusively can only be added to the Scenery Map View by
the user that has reserved it. They become unavailable and will be greyed out in the
BTS/Sector pane for all other users. The name of the reserving user will be shown in the
blocked by column of the BTS/Sector pane.

Exclusive Reservations will be kept up also when disconnecting from the AIS server and can
be removed only by the user who has reserved it, or by an administrator.

3.2.3 Configure BTS/Sector

The user has the following possibilities to configure a BTS/Sector:

Add BTS Pattern files

Load BTS Pattern files to database

Select the BTS/Sector channel

Change the frequency 

Assign BTS Pattern files to a BTS/Sector channel

Change the direction of the main beam

Configure the contour lines

3.2.3.1 Add BTS Pattern files

A pattern file is a text file describing the change of attenuation according to the radiation
pattern of an antenna. This file contains the changes in attenuation, when deviating from the
main beam for x degrees for a full 360 scale pattern.
AIS currently supports horizontal BTS Patterns.

To create a pattern file open any text file editor.

If a pattern file shall apply for a BTS or one BTS channel, it has to be of the following format:

Type NAME in in the first line. Enter a space character and type the name of the antenna
pattern
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Type FREQUENCY in the second line. Enter a space character and type in a value for the
frequency of the antenna pattern in MHz.

Type GAIN in the third line. Enter a space character and type in a value in dBd.

Type TILT in the fourth line.

Type COMMENT in the fifth line.

Type HORIZONTAL in the sixth line. This parameter determines the number of deviations
clockwise from the main fr with a user defined attenuation value beam for x degrees for a full
360 scale pattern.
Enter a space character and type in a the number of attenuation values for the antenna
pattern.

Note! This value must be a nonnegative integer and not higher than 360.

e.g.: If the user set the number of deviations in the HORIZONTAL parameter, he must fill in
no more and no less than 36 deviation values in degrees with a user defined attenuation. For
example a value at every 10 degrees.
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Type the degrees of deviation from the main beam and their attenuation value in dB in the
lines below the HORIZONTAL parameter. Use the first column of each line for the deviation
value and the second for it's attenuation.
The devation value must be a nonnegative integer.

A BTS pattern file

After filling in all values for the horizontal level type VERTICAL and proceed just as with the
horizontal.
Save file as .txt

Note! VERTICAL is NOT used but needs to be present.
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3.2.3.2 Load BTS Pattern file to database

The user has the possibility to import files describing the change of Attenuation according to
the radiation pattern of an antenna, called BTS Pattern Files, to the database and assign
them to a channel of a BTS/Sector.

To load a Pattern File to the database select FileàImport BTS Pattern File from the menu
bar.

The Open BTS Pattern Files file dialog appears. Unlike in the open scenery dialog only the
file system of the users own computer is shown. Select the file you want to import to the
database click Open.

The Open Pattern File dialog
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3.2.3.3 Select the BTS/Sector channel

If a BTS/Sector on the server consists off several channels, that are indivindually connected
to different ports, the user has to select a channel of the BTS/Sector he wants to configure.

To select the channel of a BTS/Sector, select a BTS/Sector and select a channel from the
pick list in the Channel field in the configuration pane.

The configuration pane of a BTS/Sector

Note! Any changes concerning frequency, BTS pattern files, direction of the Main Beam and
contour lines become only effective for the channel selected.

3.2.3.4 Change Frequency

 Select BTS/Sector channel.

 Fill in a value between 800MHz and 2500MHz into the Frequency input box in the Channel
field in the configuration pane.

The "Frequency" input box in the channel field in the configuration pane
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3.2.3.5 Assign a BTS Pattern File to a BTS/Sector channel

To assign an Antenna Pattern from the database to a channel, select the channel, then
select the Antenna Pattern from the pick list in the Pattern File box in the Channel field in
the configuration pane.

The Pattern File Box of the Channel field in the configuration pane

3.2.3.6 Change the direction of the main beam

To change the direction of the main beam of a BTS/Sector channel, select the channel, and
fill in a value in the Main Beam input box and press Enter. The main beam will be turned
clockwise for as many degrees as filled into the Main Beam input box. Zero degrees means
north direction.

The Main Beam input box in the channel field in the configuration pane

3.2.3.7 Configure contour lines

Each BTS/Sector channel is surrounded by contour lines displaying the signal loss according
to the frequency defined for the connected BTS/Sector channel. A Contour Line is a circle of
equal attenuation level in the AIS GUI. The contour lines show different levels of equal
attenuation up to an attenuation level of 95dB. The contour lines appear in steps up to the
maximum contour line.

Contour lines are not intended to show the complete area covered by a base station/sector.
Coverage continues beyond the outermost contour line.
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The contour lines of a BTS/Sector

The user may change the range and step width of the displayed contour lines.

To modify the range of the maximum attenuation level shown by the contour lines of a
BTS/Sector channel, select the BTS/Sector channel and fill in a value between 0dB and 95
dB into the up to input box in the Channel field of the configuration pane.

To edit steps fill in a value between 1 and the maximum Contour Line into the in steps input
box in the channel file of the configuration pane.

The channel field of the configuration pane of a BTS/Sector

The user can toggle between displaying the attenuation values that are set by the AIS server
and the actual Rx Levels that are received by the connected mobiles on the contour lines.
For this, select  View à RxLevel Values or View à Attenuation Values respectively or
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click the Att/RxLevel Button  from the Scenery Map toolbar.

In order to show the correct Rx Level values, it is necessary that the AIS server is correctly
calibrated.

3.2.4 Remove BTS/Sector

There are the following possibilities to remove a BTS/Sector from the map

Select a BTS/Sector and select Delete from map from the BTS menu.

Select a BTS/Sector and select Objects à Delete selected object from the menu bar or
press del.

Select a BTS/Sector and select Objects à Base station/sector à Delete from map from
the Menu bar.

3.3 Mobile Groups

A mobile group (MG) is a set of mobiles that are connected to the same MG output ports of
the AIS hardware and therefore receive identical RF signals from all connected BTS. They
are thus located in the same place in the AIS scenery.

The available mobile groups are shown in the mobile group pane, which also shows
connection status, running status and allocation status. Mobile groups, that are added to the
current scenery view are bold printed in the MG pane.

The mobile group pane

To run a MG it needs to be allocated, meaning a certain user reserves it. Once the MG is
reserved by a certain user it cannot be accessed by other users.

To run a MG it also needs to be connected to a trail or a random walk area It is possible to
connect several MGs to the same Trail/Random walk area.

In this section it is explained how to:

Add mobile groups to the map

Allocate mobile groups

Connect mobile groups to a trail or a random walk area
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Fix the attenuation value between a mobile group and a BTS/Sector

Delete mobile groups

3.3.1 Add MG to map

Select a mobile group from mobile group pane.

Place the mobile group on map by drag and drop.

Mobile group added to map

To change the position of a MG either drag the MG to a new position within the Map or fill in
new coordinates in the input boxes of the Position field of the configuration pane.

The Position fields of the mobile group configuration pane

3.3.2 Allocate MG on server

To allocate a MG, select the MG and select Allocate on server from the MG menu or select
from the menu bar Objects à Mobilegroup à allocate on server. The allocating user is
shown in the allocated by column of the mobile group pane. Allocated mobile groups are
unavailable and therefore greyed out in the mobile group pane for other users.
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To release a MG on the server select the MG and select De-allocate on server from the
MG menu or select from the menu bar Objects à Mobilegroup à De-allocate on server.

Mobile group menu of an allocated mobile group

Mobile allocations can be cancelled by an AIS adminstrator.

3.3.3 Connect MG to Trail/Random walk area

To connect a MG to a trail/random walk area, select the MG and select Connect to
Trail/Random area from the MG menu or select from the menu bar
ObjectsàMobilegroupàConnect to Trail/Random area. A small square now appears on
the peak of the cursor.

Mobile group menu
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Move the cursor to the Trail/Random area's RP to which the MG shall be connected. When
the RP of the trail or the random walk area turns red, click left mouse button to connect the
MG to the trail/random walk area.

You can also connect a MG to a trail/random walk area by dragging it directly from the MG
pane onto a trail/random walk area's RP.

To disconnect a MG from a trail/random walk area, select Disconnect from Trail/Random
walk area from MG menu.

The mobile group is disconnected but remains in it's current position until it is moved.

3.3.4 Locking Attenuations

The user has the possibility to fix the attenuation values between a Mobile Group and a
BTS/Sector that is positioned in the scenery. In this case, the attenuation value will be set to
the specified once and will not be modified by the AIS server according to the distance
between Mobile Group and BTS/Sector channel.

The Locking Value can be set individually for each BTS/Sector channel in the configuration
pane for a mobile group. It can be selected from the available attenuation range.

Locking Attenuation values
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3.3.5 Remove MG

There are the following possibilities to remove a MG from the map:

Select a MG and select Delete from map from the MG menu.

Select a MG and select Objects à Delete selected object from the menu bar or press del.

Select a MG and select Objects à Mobilegroup à Delete from map from the Menu bar.

3.4 Trails

A trail is an open route of linear segments in the AIS GUI, on which a MG may walk along
forth and back once or several times.

In this section it will be explained how to:

Add a new trail to map

Configure trails

Delete trail

3.4.1 Add new trail to map

Either select from the menu bar Objectsà Trail à Add to map or click on the add new

trail button  in the tool bar with left mouse button.
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Click with the left mouse button at the position on the map, where you want the new trail to
start.

Click with the left mouse button at the position on the map, where you want the segment of
the new trail to end. The minimum trail segment length is 10 meters.

Trail added to map

To add further segments of the trail, click with the left mouse button at the position on the
map where you the next segment to end, after finishing the segment before. This procedure
can be repeated as often as required.

A trail with sveral segments

To finish a trail, click with the right mouse button anywhere in the map, after finishing the last
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segment of the trail.

Note: Trails will be named only when they are finished.

3.4.2 Configure trails

The user has the following possibilities to configure a trail:

Change the position of a trail on the map 

Specify the type of trail

Set a trail as roundtrip

Specify the velocity of the wohle trail and single segments

3.4.2.1 Change Position of a trail

To change the position of a trail on the map, select a trail. Hold left mouse button to drag the
trail to a new position within the map.

To edit the positions of the segment points of a trail, fill in new coordinates for the segment
points in the position field of the configuration pane.

The configuration pane of a trail

NOTE: To change the position of a trail, the trail must NOT be connected with any mobile
groups!
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3.4.2.2 Types of trails

To specify the type of a trail, select a type from the pick list in the type field in the
configuration pane.

The pick list in the type field in the configuration pane of a trail

A trail can be specified as one of the following types:

One way: The MG walks the trail once from the start point to the end point

Return: The MG walks the trail once from the start point to the end point and returns

Cycle: The MG cycles around the trail for a certain number of times defined by the user. To
define the number of cycles, fill in a value in the input box in the type field in the
configuration pane.

Input box in the type field in the configuration pane of trail to specify the number of cycles

Cycle infinite: The MG cycles around the trail continually until it is stopped by the user.

Roundtrip: A roundtrip is closed route on which a MG circles continually until it is stopped by
the user.
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3.4.2.3 Set trail as roundtrip

Select the Trail.

Select from the menu bar Objects à Trail à Set as roundtrip or select Set as roundtrip
from the trail menu.

Trail menu

If a trail is set as a roundtrip, it is possible to choose the direction in which the MG circles
around the Trail. To choose the direction, select forward or backward from the pick list in
the type field in the configuration pane.

Type field of the configuration pane of a trail with direction pick list

To resolve a roundtrip select Resolve roundtrip from the trail menu or select from the menu
bar Objects àTrail àResolve as roundtrip.

3.4.2.4 Specify velocity for whole trail and single segments

To specify the velocity for a  trail, select a trail and fill in a value between 1km/h and 500km/h
into the input box in the speed field in the configuration pane.

The speed field in the configuration pane
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To specify the velocity of a single segment of a trail, select a trail double click with left mouse
button on the speed input box of the segment whose velocity shall be altered in the speed
field of the configuration pane and fill in a value between 1km/h and 500km/h.

The speed input boxes of the trail segments

3.4.3 Delete trail

There are the following possibilities to delete a Trail:

Select a trail and select Delete from map from the trail menu.

Select a trail and select Objects à Delete selected object from the menu bar or press del.

Select a trail and select Objects à Trail à Delete from map from the menu bar.

3.5 Random Walk Area

A Random Walk Area (RWA) is a rectangular area, in which an AIS mobile group may move
around on random paths and with random velocity continually until it is stopped by the user.

In this section it will be explained how to:

Add a Random Walk Area to map

Configure a Random Walk Area

Delete a Random Walk Area

3.5.1 Add random walk area to map

There are the following possibilities to add a RWA to the map:

Select Objects à Random walk area à Add to map from the menu bar.

Click on the add new random area button  in the tool bar.
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After executing one of these procedures click on the map in the AIS GUI at the place where
you want to locate the new RWA. Hold left mouse button and drag to set the size of the new
RWA.

Random walk area in the scenery map

3.5.2 Configure random walk area

The user can configure the following parameters of the RWA:

Size and position of the RWA 

The speed range within the MGs are walking through the RWA.

3.5.2.1 Size and position of a RWA

There are the following ways to alter the size and/or the position of a RWA:

Select a RWA and drag to the preferred size and/or the preferred position.

Select a RWA and click on one of the sides of the RWA with left mouse button. Hold the left
mouse button and drag the side of the RWA to enlarge or to downsize the RWA.
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Select a RWA and fill in new coordinates in any or all of the Left, Bottom, Right or Top
input boxes in the configuration pane.

The configuration pane of RWA

NOTE! To alter size and/or position of a RWA, the RWA must NOT be connected with
any mobile groups!

3.5.2.2 Speed range in a random walk area

To set the speed range for the mobile groups running through a RWA, mark the RWA and
fill in any value between 1km/h and 500km/h in the "from" and "to" input boxes in the speed
field of the configuration pane.

The speed field of the configuration pane of a RWA

NOTE! The minimum velocity must NOT exceed the maximum velocity!

3.5.3 Delete Random Walk Area

There are the following possibilities to delete a RWA:

Select a RWA and select Delete from map from the random area menu.

Select a RWA and select Objects à Delete selected object from the menu bar or press
del.

Select a RWA and select Objects à Random walk area à Delete from map from the
menu bar.
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3.6 Shaded area

A shaded area is a rectangular area in the AIS GUI, where the local attenuation is increased
by a user specified amount, e.g. to simulate tunnels, bridges, or radio shades of buildings.

In this section it will be explained how to:

Add a shaded area to map

Configure a shaded area

Show or hide connection between shaded area and BTS/Sector channel

Delete shaded area

3.6.1 Add shaded area to map

There are the following possibilities to add a shaded area to the map:

Select Objects à Shaded area à Add to map from the menu bar.

Click on the add new shaded area button  in the tool bar.
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After executing one of these procedures click on the map in the AIS GUI at the place where
you want to locate the new shaded area. Hold left mouse button and drag to define the size
of the new shaded area.

A shaded area in the scenery map

3.6.2 Configure shaded area

The user can configure the following parameters of a shaded area:

Size and position

The additional attenuation within the area per BTS/Sector channel

3.6.2.1 Size and position of a shaded area

There the following ways to alter the size and/or the position of a shaded area:

Select a shaded area and drag to the preferred size and/or the preferred position.

Select a shaded area and click on one of the sides of the shades area with left mouse
button. Hold the left mouse button and drag the side of the shaded area to enlarge or to
downsize shaded area.
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Select shaded area and fill in new coordinates in any or all of the Left, Bottom, Right or
Top input boxes in the configuration pane.

The configuration pane of a shaded area

3.6.2.2 Set BTS/Sector-Attenuations

The user may set a single attenuation within a shaded area for all BTS/Sector channels in
the scenery or set different attenuations for some or each of the BTS/Sector channels in the
scenery.

To define a single attenuation for every BTS/Sector channel mark the shaded area and fill in
a value between 0dB and 95dB in the input box in the BTS/Sector-Attenuations field in the
configuration pane and click on the set for all button next to the input box.

The BTS/Sector-Attenuations field in the configuration pane of a shaded area
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To modify the attenuation of selected BTS/Sector channel: Select the shaded area, then
double click on the attenuation column of the BTS/Sector channel whose attenuation you
want to change in the BTS/Sector-Attenuations field in the configuration pane. Then type in a
value between 0dB and 95dB and click with the left mouse button or press enter. The
attenuation is indicated on blue lines, if this option is switched on.

The BTS/Sector-Attenuations field in the configuration pane of a shaded area

3.6.3 Show or hide connection between shaded area and BTS/Sector channel

The connection between shaded area and BTS/Sector channel is shown by the blue lines
which indicate the attenuation

Connection between shaded area und BTS/Sectors

To show or hide the connection lines, click on the show/hide connection shaded area -

BTS button  in the tool bar, or select from the menu bar ViewàShow/Hide connection
(Shaded area - BTS)

3.6.4 Delete shaded area

There are the following possibilities to delete a shaded area:

Select a shaded area and select Delete from map from the shaded area menu.

Select a shaded area and select Objects à Delete selected object from the menu bar or
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press del.

Select a shaded area and select Objects à Shaded area à Delete from map from the
menu bar.

3.7 Fast Fading Area

A fast fading area (FFA) is a rectangular area in the AIS GUI, where the local attenuation
between MGs and BTS/Sectors is randomly varied over short distances, so that mobiles
moving through such an area experience a profile dependent fast fading effect.

In this section it will be explained how to:

Add a new fast fading area to map

Configure a fast fading area

Show or hide connection between FFA and BTS/Sector channel

Delete fast fading area from map

3.7.1 Add new fast fading area to map

There are the following possibilities to add a FFA to the map:

Select Objects à Fast Fading area à Add to map from the menu bar.

Click on the add new fast fading area button  in tool bar.
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After executing one of these procedures click on the map in the AIS GUI at the place where
you want to locate the new FFA. Hold left mouse button and drag to set the size of the new
FFA.

Fast fading area in the scenery map

3.7.2 Configure fast fading area

The user can configure the following parameters of a FFA:

Size and position

The Fast Fading profile separately for each BTS/Sector channel in the scenery

3.7.2.1 Size and position of a fast fading area

There are two ways to alter size and/or position of a FFA:

Select a FFA and drag to the preferred size and/or the preferred position.

Select a FFA and click on one of the sides of the FFA with left mouse button. Hold the left
mouse button and drag the side of the FFA to enlarge or to downsize the FFA.
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Select a FFA and fill in new coordinates in any or all of the Left, Bottom, Right or Position
input boxes in the configuration pane.

The configuration pane of a fast fading area

3.7.2.2 Fast fading profiles

The user may specify a single fast fading profile for all BTS/Sector channels in the scenery
or set different fast fading factors for some or each of the BTS/Sector channel in the
scenery.
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To set a fast fading profile for all BTS/Sector channels in the scenery: Select a fast fading
area and select a fast fading profile from the selection in the BTS/Sector-Fast Fading
Factor field of the configuration pane and click on the Set for all button next to the input
box.

"BTS/Sector-Fast Fading Factor" field of the configuration pane

To set a fast fading profile for a selected BTS/Sector channel: Select the FFA, click on the
Fast Fading Type column of the BTS/Sector channel whose fast fading profile shall be
altered in the table in the BTS/Sector-Fast Fading Factor field of the configuration pane. A
selection box appears. Select a fast fading profile from the pick list and click with the left
mouse button or press enter.

Pick list in the "BTS/Sector-Fast Fading Factor" field of the configuration pane to set fast fading profile for a
selected BTS/Sector channel

The user may choose one of the following fast fading profiles:

Rayleigh fading: The signal strength from the BTS to a mobile group moving within the area
will be calculated from the free space path loss propagation model modified by a random
value determined by the Rayleigh distribution

Rician fading from factor K=1 up to factor K=50: The signal strength from the BTS to a
mobile group moving within the area will be calculated from the free space path loss
propagation model modified by a random value determined by the Rician distribution with the
corresponding K-factor.

No Fading: The signal strength from the BTS to a mobile group moving within the area will
only be calculated by the free space path loss propagation model
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It is possible to overlap fast fading areas. In this case, always the strongest fading profile
applies. Rayleigh Fading is stronger than all Rician Fading profiles and lower K-factors are
stronger than higher ones. The effect of nested fast fading areas is displayed.

Overlapping fast fading areas
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3.7.3 Show or hide connection between FFA and BTS/Sector channel

The connection between FFA and BTS/Sector channel is shown by the red lines which
indicate the fast fading profile.

Connection between fast fading area and BTS/Sectors

To show or hide the connection lines between FFA and BTS/Sector channel, click on the

show/hide connection FastFading area - BTS button  in the tool bar, or select from
the menu bar ViewàShow/Hide connection (FastFading area - BTS)

3.7.4 Delete fast fading area from map

There are the following possibilities to delete a FFA:

Select a FFA and select Delete from map from the FFA menu.

Select a FFA and select Objects à Delete selected object from the menu bar or press del.

Select a FFA and select Objects à Fast Fading area à Delete from map from the menu
bar.

3.8 Indoor Area

A Indoor Area is a rectangular area in the AIS GUI, which represents a room / building
equipped with a picocell. The reception level inside this area, called Indoor Reception Level
in AIS, is assumed to be almost constant. So if mobiles move around in this room they will
not change their reception level.
Outside the indoor area the signals of the picocell are received with an extra attenuation due
to the walls of the building, called Wall Attenuation in AIS.
So if mobiles move outside the indoor area, their attenuation will be calculated as normal
attenuation through distance and the wall attenuation.
The same happens if a BTS is placed outside an indoor area and mobiles move inside it.
Thus their attenuation will also be calculated as normal attenuation through distance and
wall attenuation.
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The following issues are explained in this section:

Add a new indoor area to map

Configure an indoor area

Show or hide connection between indoor area and BTS/Sector

Delete an indoor area from map

Indoor area use cases

3.8.1 Add indoor area to map

There are the following possibilities to add an indoor area to the map:

Select Objects à indoor area à Add to map from the menu bar.

Click on the add new indoor area button  in the tool bar.
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After executing one of these procedures click on the map in the AIS GUI at the place where
you want to locate the new indoor area. Hold left mouse button and drag to define the size of
the new indoor area.

Indoor Area in map

3.8.2 Configure indoor area

The user can configure the following parameters of an indoor area:

Size and Position

The wall attenuation

The indoor reception level

3.8.2.1 Size and position of an indoor area

There the following ways to alter the size and/or the position of an indoor area:

Select an indoor area and drag to the preferred size and/or the preferred position.

Select an indoor area and click on one of the sides of the shades area with left mouse
button. Hold the left mouse button and drag the side of the indoor area to enlarge or to
downsize indoor area.
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Select indoor area and fill in new coordinates in any or all of the Left, Bottom, Right or Top
input boxes in the configuration pane.

The configuration pane of an indoor area
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3.8.2.2 Set wall attenuation

The user may set a single wall attenuation for an indoor area for all BTS/Sector channels in
the scenery or set different wall attenuations for some or each of the BTS/Sector channels in
the scenery.

To define a single attenuation for every BTS/Sector channel select the indoor area and fill in
a value between 0dB and 95dB in the input box in the Wall Attenuation field in the
configuration pane and click on the Set for all button next to the input box.

The Wall Attenuation field in the configuration pane of an indoor area

To modify the Wall attenuation of a selected BTS/Sector channel: Select the indoor area,
then double click on the attenuation column of the BTS/Sector channel whose Wall
attenuation you want to change in the Wall Attenuation field in the configuration pane. Then
type in a value between 0dB and 95dB and click with the left mouse button or press enter.
The attenuation is indicated on green lines, if this option is switched on.

The Wall Attenuation field in the configuration pane of an indoor area
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3.8.2.3 Set indoor reception level

The user may set a single indoor reception level for an indoor area for all BTS/Sector
channels in the scenery or set different indoor reception level for some or each of the
BTS/Sector channels in the scenery.

To define a single attenuation for every BTS/Sector channel select the indoor area and fill in
a value between 0dB and 95dB in the input box in the Indoor Reception Level field in the
configuration pane and click on the Set for all button next to the input box.

The Indoor Reception Level field in the configuration pane of an indoor area

To modify the indoor reception level of selected BTS/Sector channel: Select the indoor area,
then double click on the attenuation column of the BTS/Sector channel whose indoor
reception level you want to change in the Indoor Reception Level field in the configuration
pane. Then type in a value between 0dB and 95dB and click with the left mouse button or
press enter. The attenuation is indicated on green lines, if this option is switched on.

The Indoor Reception Level field in the configuration pane of an indoor area
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3.8.3 Show or hide connection between indoor area and BTS/Sector channel

The connection between indoor area and the BTS/Sector channels is shown by the green
lines which indicate the attenuation. The two values displayed beside the connection lines
indicate the wall attenuation and the indoor reception level.

Connection between shaded area and BTS/Sector channels

To show or hide the connection lines, click on the show/hide connection Indoor area -

BTS button  in the tool bar, or select from the menu bar ViewàShow/Hide connection
(Indoor area - BTS).

3.8.4 Delete indoor area from map

There are the following possibilities to delete an indoor area:

Select an indoor area and select Delete from map from the indoor area menu.

Select an indoor area and select Objects à Delete selected object from the menu bar or
press del.

Select an indoor area and select Objects à Indoor Area à Delete from map from the
menu bar.
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3.8.5 Indoor area use cases

If a MG is inside an indoor area and a BTS/Sector is outside the indoor area (or vice versa),
the between the MG and the BTS is the sum of all wall attenuations between MG and
BTS/Sector plus the distance attenuation.

 
MG in indoor area and BTS/Sector outside. The attenuation is the sum of the wall attenuation plus the distance

attenuation.
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If a MG and a BTS/Sector are in the same indoor area, the attenuation between BTS/Sector
and MG is the indoor reception level of the indoor area.

BTS/Sector and MG in the same indoor area

If several indoor areas overlay both the BTS/Sector and mobile, the highest indoor reception
level (the lowest attenuation) applies.

BTS/Sector and MG overlayed by two different indoor areas
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Wall attenuations of indoor areas that include neither the mobile nor the BTS/Sector are
ignored, even if the indoor area is located in between the mobile and the BTS/Sector,
because the signal finds its way around or over the indoor area.

An indoor area between BTS/Sector and mobile, including neither.

4 Running sceneries

This chapter gives a detailed overview how to run sceneries.

It will be explained here how to:

Prepare to run sceneries

Start sessions

View the attenuation data

Break sessions

Stop sessions

4.1 Preparations

To execute a scenario the following preconditions must be full filled:

The MGs that are to be started must be connected to a trail or a random walk area.

The MGs must be allocated on the server.

If the MGs are connected to a trail or a RWA and allocated on server the user may start the
movement.

4.2 Start session

There are the following possibilities to start a session:

Click on the start the session button  in tool bar or select Edit à Start session (all
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mobile groups) from the menu bar. This will automatically start every MG in the scenery
that is connected to a trail/RWA and allocated on the server and currently not running. The
start button in the tool bar is activated, if there is at least one MG in the scenery which is
connected to a trail/RWA, allocated on the server and not running.

Start a single MG by selecting a MG and selecting Start from the MG menu or select
Objects à Mobilegroup à Start from the menu bar. This will only start the selected MG to
walk the trail/RWA it is connected to.

MG menu to start selected MG

4.3 Viewing the attenuation data

The user has the following possibilities to check the attenuation data while running a
scenario:

Attenuation/RxLevel matrix view

Scenery-Logging view

Attenuation/RxLevel graph 
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4.3.1 Attenuation/RxLevel matrix view

The Attenuation/RxLevel Matrix view window displays the either attenuation or the
received RxLevel of each MG in the scenery to all the BTS/Sectors in the scenery. The
displayed values are calculated by the AIS-server. The data is recorded every second.

The attenuation data in the "Attenuation-Matrix view" window

The user can toggle between displaying the attenuation values that are set by the AIS server
and the actual Rx Levels that are received by the connected mobiles. For this, select  View
à RxLevel Values or View à Attenuation Values respectively or click the Att/RxLevel

Button  from the Matrix view toolbar.

In order to show the correct Rx Level values, it is necessary that the AIS server is correctly
calibrated.

Note: The Scenery Logging View as well as the Attenuation/RxLevel Matrix view only show
the result of the free space path loss propagation model. For performance as well as for data
storage reasons, fast fading values are not taken into consideration there.
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4.3.2 Scenery-Logging view

The Scenery-Logging view window shows updates to the scenery, the attenuation of each
MG in the scenery to all the BTS/Sectors in the scenery and the position of each mobile
group.

The data is recorded every second.

The "Scenery-Logging view" window

To delete log entries activate either the Scenery-Logging view window or the
Attenuation/RxLevel Matrix view window and stop the scenario. Select EditàTextual
LoggingàDelete log entries from the menu bar. This action cannot be undone.

Logging into the Scenery-Logging view can be disabled by selecting EditàTextual
LoggingàDisable Logging from the menu bar.

Note: The Scenery Logging View as well as the Attenuation/RxLevel Matrix view only show
the result of the free space path loss propagation model. For performance as well as for data
storage reasons, fast fading values are not taken into consideration there.

4.3.3 Attenuation/RxLevel graph

The attenuation or the received RxLevel between a MG and the BTS/Sectors can also be
shown in a graph. To show an attenuation graph select MG and select Show
Attenuation/RxLevel Graph from the MG menu.
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The Attenuation Graph

This window shows a graph for each BTS in the Scenery Map view. The displayed time
sector can be varied from 2 seconds to 1 hour by activating the respective Time resolution
button from the toolbar or by selecting the time resolution from the View -> Time period
menu.

The user can toggle between displaying the attenuation values that are set by the AIS server
and the actual Rx Levels that are received by the connected mobiles. For this, select  View
à RxLevel Values or View à Attenuation Values respectively or click the Att/RxLevel

Button  from the graph view toolbar.

In order to show the correct Rx Level values, it is necessary that the AIS server is correctly
calibrated.

The graph displays the settings on the AIS server per second. The visibility of fast fading
effects in the graph can be switched on and off by activating / deactivating the Fast Fading
Effect button or by selecting View -> Show/Hide Fast Fading Component from the menu.
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The tool bar of the attenuation graph

Graph of fast fading with a time resolution of 2s

To switch to the following or preceding time sector, use the scroll forward  or the

scroll backward   button from the toolbar.

Logging into the Attenuation/RxLevel graph can be disabled by selecting EditàAttenuation
Graph LoggingàDisable Logging from the menu bar.

4.4 Break session

To interrupt a session, click on the break the session button  in the tool bar or select
EditàBreak session (all mobile groups) from the menu bar.

Click on the break the session button again to continue the movement. The MG will
continue its movement from the point where it was interrupted.

4.5 Stop session

There are the following possibilities to stop a session:

Click on the stop the session button  in tool bar or select EditàStop session (all
mobile groups) from the menu bar. This will terminate the entire session at once. The stop
the session button is activated, if at least one MG in the scenery is running.

Note! If the movement of an MG is stopped it cannot be restarted from the current position!
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The user may also stop only a single MG by selecting the MG and selecting Stop from the
MG menu. This only stop the selected MG whilst the other MGs in the scenery will continue
to run the trails/RWAs they are connected to.

MG menu to stop selected MG

5 Dynamic Scenery View

If an AIS system is equipped with a m x n switch matrix, where m specifies the number of base
stations, that can be connected to the AIS system and n specifies the number of BTS input ports into
the AIS subrack, the Dynamic Scenery View is an optional feature, that allows to place more base
stations on a scenery than BTS input ports are available. The AIS application automatically switches
the strongest base stations to the subrack input ports.

Since it is not possible to switch one base station to different subrack input ports at the same time, the
usage of base stations requires exclusivity regarding users testing on the same switch matrix. For
mobile groups, that are used in this mode, the allocation concept is not enough. Additionally, base
station input ports have to be reserved in order to guarantee the signal of the desired number of
strongest base stations at any time.

The following chapters explains how to work with the Dynamic Scenery View, i.e.

How to switch to the Dynamic Scenery Mode

The switching exclusive reservation of base stations

The reservation of base station input ports

The differences in the execution of sceneries in Dynamic Scenery Mode, compared to the Normal
Scenery Mode.

5.1 Dynamic Scenery Mode

In order to enter the dynamic scenery mode, select

File -> Switch to ... -> Dynamic Scenery Mode
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from the Normal Scenery View menu.

To switch back to Normal Scenery Mode, select

File -> Switch to ... -> Normal Scenery Mode

from the Dynamic Scenery view menu.

Note: Open Sceneries have to be closed before leaving the respective mode.

5.2 BTS port reservation

In Dynamic Scenery Mode, the tester can decide, how many of the AIS subrack BTS input ports shall
be reserved for his test session. The number of desired input ports are exclusively reserved for this
tester upon mobile allocation. When reserving a number of ports k, the AIS application always switches
the k strongest Base Stations to the reserved ports. The signal of other base stations switched to other
than the reserved input ports does not become visible for the selected mobile group.

To reserve a number of ports for one mobile group, select

Reserve and Allocate -> (k) Ports

from the mobile group menu. The number of reserved BTS input ports is displayed in the mobile group
configuration pane.

Port Reservation

If ports are reserved by one user, the number of available ports that is free for other users decreases
automatically. The number of public available ports is always indicated in the status bar of the AIS
client GUI.

Public available Ports decreased by 2

BTS port reservations can be cancelled by an AIS adminstrator.

5.3 Switching exclusive BTS reservation

It is not possible to switch one BTS at the same time to more than one BTS input port on the AIS
subrack. In order to gurantee, that a BTS is free for being switched on one of the reserved ports at the
moment where it is one of the k strongest ones in the scenery, the usage of each BTS placed in the
scenery must be exclusive regarding all the other users on the same switch matrix. For that reason,
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base stations, that are placed on the scenery automatically become reserved switching exclusive. This
exclusivity is displayed with the user name and the switch matrix number in the switching exclusive
column of the BTS/Sector pane.

A switching exclusive BTS reservation can also be achieved without placing the BTS into the scenery
by selecting Exclusive Switch Reservation from the BTS menu.

Explicit exclusive Switch Reservation in Dynamic Scenery Mode

If a base station is reserved switching exclusively, it automatically becomes unavailable for other users
operating on the same switch matrix. Users working on other switch matrices still have full access to
the base stations. On the other hand, base stations that are already in use cannot be reserved
switching exclusively.

Switching exclusive reservations can be cancelled by an AIS adminstrator.

5.4 Running Sceneries in Dynamic Mode

Sceneries can be drawn with the same objects and
started in the same way as in Normal Scenery Mode. The only difference is only the signal of the k
strongest base stations is actually seen by the mobile group in use. The base stations, that are
currently switched to the reserved BTS input ports are marked with the testers name in the used by
column of the BTS/Sector pane. All base stations placed in the scenery are visible in the
Attenuation / Rx-Level Matrix View and in the Attenuation / Rx-Level Graph View, where those BTS
that do not belong to the k strongest ones, are automatically set to maximum attenuation / minimum
Rx-Level.
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Running a scenery in Dynamic Scenery Mode with 2 reserved BTS ports

6 Table file view

The table file view is an application of its own within AIS. It shows the attenuation of MGs to
BTS/Sectors at user specified time stamps according to a user created comma or semicolon
separated value (csv) file.

Table files are useful to replay a recorded scenario from field measurements or to create an
artificial RF-Scenario, that cannot be reproduced by placing base stations in the scenery
window.

Table files may be saved in the filesystem of the user's computer or in the local database
and are accesible in both without any impairment of serviceability.

In this section it will be explained how to:

Enter the table file mode

Create .csv table files

Import table files to database

Delete table files from database
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Work with table files in the AIS

Run table files

6.1 Table File Mode

In order to enter the table file mode, select

File -> Switch to ... -> Table File Mode

from the Scenery View menu.

To switch back to Scenery Mode, select

File -> Switch to ... -> Scenery Mode

from the Table File menu.

Note: Open Sceneries or Table Files have to be closed before leaving the respective mode.

6.2 Creating .csv table files

Open Excel.

Specify the columns: The columns must be named as follows:
Column A = t
Column B = MG
From column C on the columns must be named according to the BTS/Sectors in ascending
order, e.g. BTS1; BTS2; BTS3;…
The user may also leave out some BTS/Sectors as long as an ascending order is kept, e.g.
BTS1; BTS3; BTS5;…

Fill the time stamps in ms in the of t column. The first time stamp must be t=0, the difference
between two subsequent time stamps must be at least 1 ms.

Fill the number of MG ID in the MG column

Fill in a level of attenuation between 0dB and 95dB in each of the BTS columns for every
time stamp. To keep the attenuation level for two or more time stamps fill in the same value
at these time stamps.

Save file as .csv file.
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Example for a .csv table file in Excel

Note: Depending on the default language, Excel creates .csv files with commas or with
semicolons as separator. Both is accepted by AIS, but no other separator can be used!

6.3 Import table files to database

To import a table file to the database switch to the table file mode.
Select from the menu bar FileàImport table file into Database or press the import table

file button .
The open table file dialog appears. Unlike in the open scenery dialog only the file system of
the users own computer is shown. Select table file and click open.

The open table file dialog
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The Import table file into database dialog appears. Fill in a name under which the table file
shall be displayed in the database in Name field of the Import table file into database dialog
and click Import.

The Import table file into database

Note! If the user wants to import a table file whilst working with another table file, a pop up
dialog appears asking whether to import the currently loaded table file. Click Yes to import
the currently loaded table file.

6.4 Delete table files from database

The user has the following options to delete a table file from the database:

Select FileàLoad table file to database from the menu bar or press the load table file

button . The Load table file from database dialog appears. Select the table file you
want to delete in the list and click on the Delete button. A confirmation dialog appears. Click
Yes to delete the table file from the database.

Select from the FileàImport table file to database from the menu bar or press the import

table file button . Select a table file and click open. The Import table file into database
dialog appears. Select the table file you want to delete in the list and click on the Delete
button. A confirmation dialog appears. Click Yes to delete the table file from the database.

6.5 Working with table files in AIS

Open table file in the file system of the users computer or load a table file from database.
To open a table file from the file system, select from the menu bar FileàOpen Table File

from Disk ... or click on the open table file button  in tool bar. The open table file
dialog appears. Unlike in the open scenery dialog only the file system of the users own
computer is shown. Select table file and click open.
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The open table file dialog

To load a table file from database, select from the menu bar FileàOpen Table File from

Database ... or press the load table file button . The Load table file from database
dialog appears. Select the table file and click Load.

The Load table file from database dialog

The user specified settings of the table file are displayed in table text pane below the tool
bar.
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The  "Table file view" window

Below the table text pane there is a graphic view of the settings displayed in the table graph
pane. One graph for each MG is displayed and one line for each BTS/Sector in the same
color as in the scenery.

The table graph pane

The user can toggle between displaying the attenuation values that are set by the AIS server
and the actual Rx Levels that are received by the connected mobiles in the graph. For this,
select  View à RxLevel Values or View à Attenuation Values respectively or click the
Att/RxLevel Button from the graph view toolbar. This does not apply for the table text pane,
that only shows the attenuation values.

In order to show the correct Rx Level values, it is necessary that the AIS server is correctly
calibrated.

Note: The Table file should describe a period of at least 1000 ms. The application works
also with smaller time periods, but the displayed graphic in the table graph pane has a very
bad resolution.

6.6 Running table files

Specify the number of repetitions: Either select a number of repetitions from the selection
box in the table file settings bar or in case the table file shall be repeated until it is stopped
by the user tick infinite box in the table file settings bar.
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Make sure that the involved MGs are not allocated on the scenery window. The MGs
involved will be allocated at start time and remain allocated until the table file execution is
stopped.

The table file settings bar

Start table file: Either click on the Start button  in the tool bar or select Edit à Start
table file from the menu bar. Before the application starts a please wait info box appears.
This box remains on the screen for the time it requires to transmit the table files data to the
server, this might be a few moments.

As soon as the execution of the table file starts a black vertical bar is displayed, which
indicates the current time of the log file.

View of a table file graph while running

Interrupt table file execution: Either click on the Pause table file button  in the tool bar
or select EditàPause table file from the menu bar. To continue either click on the Pause
table file button in the tool bar again or selecting EditàPause table file from  menu bar
again.

When the user the restarts the table file the application will continue at the next time stamp
in the table graph pane.

Note: A table file should not be stopped, when it is very close to the end of the execution
(<200 ms). This confuses the message flow between client and server.

Stop table file. Either click on the Stop button  in the tool bar or select EditàStopTable
File from the menu bar. If the table file is stopped, it can only be restarted at the beginning.

7 Prediction Profile View

The Prediction Profile View is an application of its own within AIS. It enables the user to load
predictions, that has been generated with a network planning tool and to simulate a movement within
this prediction according to the calculated values.
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In order to simulate a prediction in a given area with AIS, it is necessary to have prediction files
containing only one Base Station for the whole area. It is not possible to simulate a prediction, that
contains the signal of more than one Base Station. Thus, if for example 4 Base Stations are involved,
AIS needs individual predictions for each single Base Station. With AIS it is possible to display views
like maximum field strength or best serving base station.

In this section it will be explained how to:

Enter the Prediction Profile Mode

Import prediction profiles

Use a Base Station in Prediction Profile Mode

Select different views on the prediction

Run a simulation with AIS in the predicted environment

7.1 Prediction Profile Mode

In order to enter the Prediction Profile Mode, select

File -> Switch to ... -> Prediction Profile Mode

from the Scenery View menu.

To switch back to Scenery Mode, select

File -> Switch to ... -> Scenery Mode

from the Prediction Profile View menu.

Note: Open Sceneries have to be closed before leaving the respective mode.

7.2 Import Prediction Profiles

Prediction Profiles have to be saved in the local file system as .3ga files. One file must not contain the
prediction of more than one Base Station in a given area.

To make a prediction profile available for AIS, it has to be imported into the AIS Database.

From the Prediction Profiles View menu select

File -> Import Prediction Profile Files into Database ...

Select all files of .3ga format for import from the file system and press the "Open" button. A progress
bar indicates, how far the import of a Prediction Profile File has proceeded.

To delete Prediction Profile Files from the Database select

File -> Delete Prediction Profiles ...

Select the files you want to delete by name and press the "Delete" button.
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7.3 Assigning Prediction Profiles to Base Stations

To use a Prediction Profile for simulation, it must be assigned to a Base Station.

In Prediction Profile View, Base Stations cannot be dragged as in Scenery View. Their
position within the simulated area is determined by the prediction profile. To use a Base
Station for simulation, select Use for predict simulation from the Base Station Context
Menu, that can be opened on right mouse click on the base station name in the BTS pane.

The BTS context menu in Prediction Profile Mode

If the Base Station is in use, it is printed in bold letters and the user name is indicated in the
used by column.

The prediction profile that shall be assigned to the base station can now be selected from
the BTS properties window.

Note: All Base Stations used in one simulation must have prediction profiles for the same
area assigned. For this reason, only prediction profiles with matching dimensions are offered
to the user as soon as there is a prediction profile assigned to one base station. The other
ones are not offered in the selection list, though they are imported into the database. To
make them visible again, all assigments need to be removed from all base stations in use.

The predicted enviroment will be displayed in the Prediction Profile view. A legend in the
base station properties view displays, how to interprete the colours in terms of Rx-Levels.
When dragging the mouse pointer over the predicted environment, the coordinates and the
predicted field strength will be displayed for each position.
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Prediction profile for one base station loaded into the Prediction Profile View

7.4 Changing Prediction Views

AIS offers several views on the predicted area.

By default, when selecting one base station in the BTS pane, the prediction for this single
base station is displayed in the Prediction Profile View. Besides to that, the User can display
the maximal field strength or the best server on the whole predicted area. To switch to these
views select

View -> Display maximal field strength

or

View -> Display best serving base station

To facilitate distinguishing the base stations in the Best Serving Base Station View, the user
has the possiblity to assign a colour of his choice to each base station over the BTS context
menu.
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Assigning a colour to a base station for Best Serving Base Station View

The area that is covered with maximum field strenght by a base station is displayed in the
selected colour. The colour also applies to the Attenuation Graph View.

              

The Best Serving Base Station View and the Attenuation Graph with user specified colours
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Note: AIS switches back automatically to the default view of one base station profile, if a
base station is selected from the BTS pane.

7.5 Running a simulation

Prerequisite to run a simulation in Prediction Profile Mode, is, that at least one Prediction
Profile is assigned to a base station. After that, that prediction is displayed in the Prediction
Profile View, which can be used in the same way as the Scenery View:

All other objects except base stations can be placed anywhere in the simulated environment
as described in the objects chapter. Simulations can be started as described in the chapter
Running Sceneries.

A mobile group running on a trail in Prediction Profile Mode

Note: To receive the correct Rx Levels on the mobiles connected to AIS as they are
displayed in the Prediction Profile View, it is necessary to calibrate the server by an AIS
administrator before starting a simulation.

8 AIS Administration GUI

The Administration GUI displays the AIS setup and the licensed features and enables users
with administrator rights to

- Configure the mobile groups and base stations,

- Administrate users of the AIS system and their access rights,

- Calibrate the AIS server according to HF measurements on the hardware.

8.1 Open Administration GUI

To start the Administration GUI select
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Start -> Program Files -> Qosmotec -> AIS -> Air Interface Simulator Administration

The login dialog opens.

The mechanism to login to the AIS Administration GUI is identical with
logging in to the AIS GUI.

8.2 AIS Setup Information

The Information tab of the AIS Administration GUI lists the following AIS setup information:

· The AIS server version,

· The number of concurrently usable GUI licenses on this AIS server,

· The number of base stations, that is served by this AIS server,

· The number of Switch Matrix ports, that is served by this AIS server (if switch matrix
hardware is part of the system),

· The number of Mobile Group ports, that are served by this AIS server,

· The software features, that are licensed on this AIS server.

Note: It is not possible to edit anything in this tab!
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The Information tab of the AIS Administrator GUI

8.3 Mobile Configuration

The Mobile Configuration tab of the AIS Administration GUI lists all mobile groups, that are
served by this AIS server.

A user with administrator rights is allowed to change the name of the mobile group.

Changes on the mobile group names must be confirmed by pressing the Apply-Button. The
user will be prompted for saving changes, if he leaves this tab or closes the AIS
Administration GUI.

Note: A normal user is only allowed to read the settings, but not to change mobile group
names.
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The Mobile Configuration tab of the AIS Administrator GUI

8.4 Base Station Configuration

The BTS Configuration tab of the AIS Administration GUI lists all base stations and their
properties, that are served by this AIS server.

A user with administrator rights is allowed to change the name of the base station, the
frequency, the radiation power and the electrical pre-attenuation (attenuation value, that is
added automatically and reduces the variable attenuation range).

An administrator can also allow, that several channels of the same base station can be
connected to different base station ports of the AIS hardware. This can be realized by
selecting one base station, activating the "Allow multichannel" field and clicking the up-button
in to "Number of channels" field. This accumulates the AIS base stations ports to one BTS
(see column "Used ports"). The number of channels per BTS can be reduced by clicking the
down-button in the "Number of channels" field.

Note: Increasing the number of channels for one BTS decreases the number of individual
base stations.

Any change must be confirmed by pressing the Apply-Button. The user will be prompted for
saving changes, if he leaves this tab or closes the AIS Administration GUI.

Note: A normal user is only allowed to read the settings, but not to change the properties.
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The Base Station Configuration tab of the AIS Administration GUI

If there is one AIS Port, where no base station is connected to, it is not necessary to delete
the base station in the Admin GUI. It can simply be set to inactive by unselecting the
"Running" checkbox next to the base station name. An inactive base station port is indicated
as greyed out, italic name in the BTS pane of AIS and cannot be used in a scenery.

BTS pane with BTS/Sector 1 set to inactive

8.5 User Administration

The User tab of the AIS Administration GUI lists all users and their execution rights, that are
allowed to log in into the AIS server

A user with administrator rights is allowed to add or remove users or to change the execution
rights (Admin/Normal) of existing users

Any change must be confirmed by pressing the Apply-Button. The user will be prompted for
saving changes, if he leaves this tab or closes the AIS Administration GUI.

Note: A normal user is only allowed to read the settings, but not to change the properties.
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The User tab of the AIS Administration GUI

8.6 Server Calibration

The AIS Server can be calibrated over the AIS Administration GUI. For that, the output
power of the Base Station needs to be measured as well as the power level, that is received
by the mobile groups.

The AIS Server calibration is necessary for getting the correct values when toggling between
Attenuation and RxLevel values in the Scenery view.

The calibration can be started by selecting Tools -> Calibrate ... or by pressing the

calibration button .

Note: Starting a calibration will disconnect all users from the AIS server and stop all running
tests!

The calibration algorithm itsself depends on the setup of the AIS system. The basic idea is to
measure the BTS output power and to measure the received Rx Level for each mobile
group. If the AIS is equipped with a digital switch matrix, each base station needs to be
switched to each port of the switch matrix.

For each base station that can be used by the AIS server, the radiation power level needs to
be measured. This output power needs to be entered in the AIS calibration setup wizzard.
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Entering the BTS radiation power for calibration

If the AIS system is equipped with a digital switch matrix, for each base station and each
switch matrix port that is served by the AIS server, the reception power level on mobile group
1 needs to be measured. This reception level needs to be entered in the AIS calibration
setup wizzard. If there is no switch matrix, the signal level needs to be entered only once.

Entering Reception Power per switch matrix port for BTS 1 and MG 1

Finally, the reception power level for every other mobile group needs to be measured when
base station 1 is switched on each switch matrix port. The reception level needs to be
entered in the AIS calibration setup wizzard. If there is no switch matrix, the signal level on
mobile group side needs to be measured for each mobile group to each base station
instead.
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Entering Reception Power per switch matrix port for BTS 1 and all other Mobile groups

Press the Calibrate Button  that appears, when you have reached the last switch matrix
port on the last mobile group.

9 Trouble Shooting

This chapter summarizes typical errors or and explains reasons or potential error sources.

When an error occurs or you do not now how to handle the tool, try to solve your problems
first with readint the following sections. If you do not succeed with the hints given here or any
other problem occurs, that is not described, please write a detailled bug report to
support@qosmotec.com.

9.1 No Login to AIS possible

Problem:

The client GUI cannot connect to the AIS server. After some seconds the following error
message appears

No Connection to AIS Server

Check the following:

- Is the AIS subrack reachable over the network? Try to ping it!
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- Check the server connection settings in the login dialog

- Check the firewall on your client PC.

- Contact your system administrator to check the running processes and the configuration on
the AIS subrack.

9.2 Wrong User Name or Password

Problem:

The client GUI cannot connect to the AIS server with username/password error. The
following error message appears

Invalid user name or password

Check the following:

- Have user name and password been correctly typed into the login dialog?

- Is the keyboard switched to captital letters, when typing the password?

- Contact your system administrator to check, if the user/password is added on the AIS
subrack.

9.3 No Free Licenses

Problem:

The client GUI cannot connect to the AIS server due to missing licenses. The following error
message appears

Number of available licenses exceeded

Check the following:

- Who has logged in to the AIS server? The number of floating GUI licenses cannot be
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exceeded.

- Check on your own computer, if still other client GUIs are open.

- Check also, if nobody is connected to the AIS server with an AIS Administration GUI. This
also requires one floating license.

- Only in case, that the current license users cannot be found, the AIS HW may be restarted.

NOTE: All other connected users will be automatically disconnected and their tests will be
interrupted in this case ! ! !

9.4 Cannot allocate mobile group

A mobile group cannot be allocated. When selecting Allocate on server from the MG menu,
the following error message appears

Mobile Group allocation failure

Check the following:

- Who has the requested mobile group currently in use? The resource manager does not
allow concurrent usage of mobile groups.

- Check on your own computer, you have allocated the mobile group in another open GUI.

- Check also, if in use by a running table file. For executing table files, the mobile groups are
automatically allocated by AIS.

- Only in case, that the current user of a mobile group cannot be found, the AIS HW may be
restarted.
NOTE: All other connected users will be automatically disconnected and their tests will be
interrupted in this case ! ! !

9.5 Cannot move a mobile group on the scenery window

Problem:

A mobile group cannot be moved with the mouse on the scenery window

Check the following:

- Is the mobile group connected to a trail or random walk area? In this case, it must be
disconnected, before it can be moved.



Trouble Shooting 95

© <2005> Qosmotec Software Solutions GmbH

9.6 Cannot Edit Trail / Random Walk Area Properties

Problem:

The properties of a trail or random walk area cannot be edited.

Check the following:

- Can you see the properties pane of the trail or random walk area? If the reference points of
several objects are placed over each other, you have to click with several mouse clicks to
change the visibility of the configuration panes.

- Is any mobile group connected to or running on the trail or random walk area? The
properties can only be edited, if the object is free.

- Have you clicked "Enter" or anywhere into the scenery window to apply the change? This
must be done to activate the setting.

9.7 No attenuation shown in the attenuation matrix

Problem:

A mobile group is positioned on the scenery window, but there is no attenuation value
displayed in the attenuation matrix view.

Check the following:

- Is the mobile group allocated? Attenuation values are only set for mobile groups reserved
for the specific user.

- Is a BTS/Sector positioned on the scenery window? Attenuations are calculated according
to the distance between mobile group and BTS/Sector.

9.8 Start button does not become active

Problem:

You want to start a mobile group on a trail or random walk area, but the global start button is
inactive

Check the following:

- Is the mobile group allocated? Only mobile groups, reserved by the user, can be started.

- Is the mobile group connected to the trail or random walk area? May be, the mobile group
icon simply overlaps with the reference point of the object. If you can still move the mobile
group with the mouse, it is not connected to any trail or random walk area.

- If a mobile group can be started, the "Start" entry in the mobile group menu becomes
active, so that it can also be started from there.
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9.9 Mobile Group does not move on start

Problem:

You press the global start button, but your mobile group does not start to move.

Check the following:

- Is the global start button active because another mobile group was ready for start? Check,
if another mobile group started to move.

- Is the mobile group allocated? Only mobile groups, reserved by the user, can be started.

- Is the mobile group connected to the trail or random walk area? May be, the mobile group
icon simply overlaps with the reference point of the object. If you can still move the mobile
group with the mouse, it is not connected to any trail or random walk area.

- If a mobile group can be started, the "Start" entry in the mobile group menu becomes
active, so that it can also be started from there.

9.10 Attenuation values do not change during movement

Problem:

The mobile group moves on a trail or random walk area, but the attenuation values in the
attenuation matrix view do not change.

Check the following:

- Is the attenuation between mobile group and BTS/Sector locked to a specific value? In this
case the locking value remains, independant from the distance.

- Is the mobile group moving in a big distance from the BTS/Sector? The attenuation in dB is
a logarithmic value. In close distance to the BTS/Sector the 1dB steps are significantly
smaller than in large distance.

9.11 Cannot see fast fading area graph

Problem:

A mobile group has moved through a fast fading area, but the attenuation graph view does
not show fluctuating values.

Check the following:

- Is the Fast Fading Effect button activated? If this button is inactive, only the distance
dependant attenuation values are displayed in the attenuation graph.



Trouble Shooting 97

© <2005> Qosmotec Software Solutions GmbH

- Has the mobile already left the fast fading area? The fast fading values are only updated, if
the area is completely passed, or if the mobile group has changed its direction within the
area when moving through a random walk area.

- Is the correct time window displayed? Depending on the selected time resolution, it might
be necessary to scroll through the attenuation graph window to see the correct time window,
when the mobile group has passed the fast fading area.

9.12 Cannot Open Table File

Problem:

A table file cannot be opened in the AIS table file view.

Check the following:

- Does it have the right format? Are all values separated by commas or semicolons? If the
separator is not correct, the following error message appears:

Wrong separator in table file

- Does it use an invalid Mobile Group? If a mobile group outside the available range (e.g. MG
5 for a 4x4 specification) is specified, the following error message appears:

Mobile Group specified in table file does not exist

- Does it use an invalid BTS/Sector? If a BTS/Sector outside the available range (e.g.
BTS/Sector 5 for a 4x4 specification) is specified, the following error message appears:
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BTS/Sector specified in table file does not exist

- Is a BTS/Sector used twice? A BTS/Sector must only appear in one column. If the same
one is reused, the following error message appears:

The same BTS/Sector used mulitple times

- Does the table file start with time stamp 0? If not, the following error message appears:

Wrong time stamp in table file

- Are the time stamps sorted in ascending order? Is there a minimum time gap of 1 ms
between the specified time stamps in the table file? You cannot specify two lines with the
same time stamp, even not for different mobile groups. If not, the following error message
appears:

Time stamps not sorted correctly in table file
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9.13 Bad resolution of table file graph

Problem:

When a table file is loaded, the graph, that displays the attenuations consists of very thick
lines and seems to have a bad resolution.

Check the following:

- Is the time period, described in the table file less than 1000 ms? In this case, it is simply a
problem of the representation in the table graph pane. This does not affect the application at
all.
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